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AARP Tax-Aide ERO Training

 Objectives (Be able to):

 Use TaxWise to transmit tax returns

 Receive and respond to acknowledgements 
and rejects

 Update TaxWise on ERO and EFC computers 

 Manage tax return e-files and paperwork

 Maintain security of taxpayer data
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Assumptions

 You have been a TaxWise EFC

 You will not be running TaxWise on a 
network

 You will transmit all returns prepared with 
your EFIN

 You will transmit and receive 
Acknowledgements from home

 You have a broadband internet connection 
(or access to one)
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There is no single right way!

 Discuss preferred or recommended
ways 

 Describe good practices

 Provide references for options
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What EROs Get

 From IRS Andover – EFIN letter
 New EFIN: 4 to 6 weeks after applying
 Changed/Renewed EFIN: December

 From CCH – December
 TaxWise CD
 Registration Code

 TaxWise User Manual
 Access to web site downloads, 

knowledge base, etc.
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Taxwise Software Package

 CD

 EFIN

 Registration Code

 Client ID number

 Make copy of letter and save 
separately
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Customer Support Tab

 Links to TW support

 Need client id

 Password ADMIN

 You create password
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What EFC’s Need

 TrueCrypt

 TaxWise 2010
 Unique DCN

 New Jersey

 Periodic updates

 Printer drivers

 Wireless printer network setup 
(optional)

 Passwords
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Agenda

 Site operations

 Transmit returns

 Acks, Rejects and ERO paperwork

 TaxWise Updates

 Reports, Utilities, Tech Tips and 
Good Practices

 Post-season
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Start your computers!

 computers

 Login:

 Password:



 All computers – Caps Lock 
recommended
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USERS

 ADMIN

 Training

 Guest

 Site name(s)

 Password first 3 to prevent EFC 
errors
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Let’s see what we can find

 1. find EFIN on your machine

 2. find DCN

 3.printer default

 TOOLS-UTILITY/SETUP-SETUP 
OPTIONS
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LOG INTO any USER

 NOW WE CAN PLAY
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ERO Module 1 – Site 

Operations

In the Tax-Aide Program

…training is the brains

…counseling is the heart & soul

…transmitting is the voice
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SITE PROCEDURES

Assure SIDN is setup on all 
computers

Assure DCN has a different start 
number for each computer

Quality review each return
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Data Retention – What & Why

 One electronic copy of the return 
may be retained for an additional 
year

 Returns prepared with retained data 
should have fewer errors and take 
less time
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Data Retention

 IRS now allows us to keep data for 
year

 Do not need permission of Taxpayer
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Quality Review

Do your clients a favor:  send them out the 
door with a return without errors!

 Tax return review – required by IRS 

 E-file review – prudent to minimize 
rejects

 Review on computer –reviewer should 
have TaxWise training

 Review data on paper –W-2, 1099s and 
other statements
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Backing up returns

 Backup can be done to a Flash 
Drive

 A folder on the backup media for 
each EFC is recommended



2009 Tax season ERO TRAINING - MODULE 0 19

TaxWise offers three methods of 

Backup

 Transfer IRS/RAL 
files to 
transmitting PC

 This method is not 
recommended

 Regular backup

 Recommended 
method

 Advanced backup 
options
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Backing up returns

 Stop and play with back ups

 One flash drive, multiple EFCs
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My thumbdrive folders

 Carla

 Maria

 Steve

 Complete (ACCEPTED RETURNS I 
NO LONGER NEED TO LOOK AT)
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LETS MAKE FOLDERS

 INSERT THUMBDRIVE 

 SCREEN WILL APPEAR SHOWING 
WHAT’S ON DRIVE

 RIGHT CLICK ON SCREEN

 NEW

 FOLDER

 NAME IT

 MAKE 3 FOLDERS
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 Log in as the 
appropriate user

 Open the Tools menu

 Select Backup to Disk

 Select Regular Backup

 Click OK

 Select the user name(s) 
whose returns you want 
to backup

 Press Enter or Click OK

Regular Backup backs up tax returns

and all related files (Recommended)
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 Select the returns from 
each user name
 Click the Select All button 

to backup all returns

 Press enter or click OK
 Select the drive and/or 

directory for backup
 If you are using floppy disk, 

remember to number the 
disks

 Press enter or click OK
 Click OK on the Backup 

Complete confirmation 
box

The next step is selecting the returns
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Security of Backup files

 2 files, encrypted

 Files always have the same names: 
will erase previous backups

 May be emailed (not recommended)

 Delete at the end of the season
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RESTORE

 From flash to your computer
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 Login with the appropriate 
user name

 Returns will not restore to 
Admin

 Open the Tools menu

 Select Restore from Disk

 Select Restore from Full 
Backup

 Click OK

Restore from Full Backup restores 

returns to the active user name
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 Select the drive that 
contains your backup

 Select the user 
name(s) to restore 
returns from
 The user name must be 

on the computer you 
are restoring to

 Click OK

 Select the returns to 
restore
 Restores to active user

 Click OK

Selecting the returns to Restore

from Full Backup
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Erase Returns when Appropriate

 Delete returns from EFC computer 
when no longer needed.

 Don’t erase returns until they exist in a 
second place.

 Transmitted returns can be deleted 
from backup disk.

 Accepted returns can be deleted from 
preparing computer if saved elsewhere.
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Deleting Returns from EFC Computer

 Tools/Utility Setup/File/erase efiles

 Another way: for you!

 Tools/Utility Setup/File/Taxwise 
Explorer/user

 Highlight returns/action/delete
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Security Note

 Deleting a return does not remove 
all taxpayer data.

 A summary of the tax return 
remains in the TaxWise database 
even after the return is deleted.
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Comments
Questions
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ERO (Transmitter) Training

Module 2

Getting Ready to 
Transmit
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Transmitting Computer

 Set DCN to unique starting 
number

 Use the same computer to 
transmit returns and receive 
ACKs all season

 Required for complete TaxWise 
database

 Contact UTS if computer fails
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Before you transmit

Verify desired returns restored

 match Site Sign-In Sheet

 match signature documents

Verify signature documents 
(DCN, SIDN & site name) and 
backup forms (W-2’s, 1099’s 
etc.)
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Make IRS e-files

 Recommended before each 
transmitting session

 Runs diagnostics without opening 
returns

 Ensures current e-file before 
transmitting

 Tools/Make IRS e-files

 Select the returns individually or 
with Select All
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TaxWise runs diagnostics on all 

returns selected

 Status message will 
appear if returns have 
e-file errors

 Click OK

 Review the errors in 
the Diagnostics 
Results window

 Errors found.  Could 
not create IRS 
electronic return

 IRS Electronic return is 
created and stored on 
disk



2009 Tax season ERO TRAINING - MODULE 0 38

 Must open the 
return to 
correct any e-
file errors

Make IRS e-files does not allow 

the user to correct e-file errors
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Creating the e-file from Inside the Tax 

Return (Generally done by QR)

 Log in as the 
appropriate user

 Open the 
completed return

 Run Diagnostics
 Press F10 from the 

Forms list

 Click on the 
diagnostics icon

 Press Ctrl-D

 Will be covered in a 
later session

 Click the E-file
button
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Comments
Questions

Ready to Transmit



2009 Tax Season ERO TRAINING - MODULE 0 41

ERO (Transmitter) Training

Module 3

Transmitting
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THE PROCESS

 Fed/St to CCH

 CCH to IRS

 Fed ok? Then State sent on

 Fed –bad- both held back

 Acknowledgement sent to ERO

 Fix bad and resend both
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IRS Federal/State e-file program

 State return is sent with 
the Federal return to the 
IRS

 Federal return is accepted

 IRS makes the state e-file 
available for the state

 Federal return is rejected

 State e-file is not available 
for the state

 Must file the state again 
when the Federal is re-sent
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Federal Accepted, NJ Rejected

 The New Jersey return can be 
corrected and retransmitted 
electronically

 Alternatively, the New Jersey return 
can be mailed



2009 Tax season ERO TRAINING - MODULE 0 45

Things to do before you transmit

e-files to CCH

 Create the e-file for 
one or more returns

 Internet connection 
must be active if 
transmitting via the 
Internet

 Printer must be turned 
on and ready to print 
the Declaration Control 
Report (DCR)!
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Transmitting your Federal and State returns 

to the TaxWise Electronic Filing Center

 Login with the 
appropriate user name

 Users assigned to the 
Training Group will 
transmit to the Training 
Electronic Filing Center

 Open the 
Communications menu

 Will display a warning 
box if the user is 
assigned to the Training 
group

 Select Send 
Federal/State Returns 
to…

 Shortcut Ctrl-S
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 Transmission 
destination 
defaults to Send 
Returns to the 
Electronic Filing 
Center

 Select the returns 
to send

 Only displays 
eligible e-files

 Select Returns to 
file window opens

 Click Send

Selecting returns to send to the 

Electronic Filing Center
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Caution

 It is possible to have a file ready to 
transmit

 But you are missing completed 
paperwork

 DO NOT EFILE
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 Things to look for:

 Refund/Balance due 
amount is correct

 Number of returns correct

 Returns on DCR match 
those ready to send

 Returns omitted due to 
batching errors (Error 
189)

 State return indication 
correct

 Verify signed signature 
documents for each return

Review the Declaration Control 

Report before transmitting
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 Click the Printer icon

 Click OK to print

 Click Cancel to 
quit the printing 
process

 Verify the DCR 
printed

 Close the DCR 
window

 Click the X in the 
upper right corner 
of the window

Print the Declaration Control 

Report (DCR)



2009 Tax season ERO TRAINING - MODULE 0 51

 Click Yes if the 
information on the 
DCR is correct

 The transmission 
process will begin

 Click No if the 
information on the 
DCR is not correct

 Cancels the 
transmission

 E-files remain on 
your system to 
correct and resend

Answer Yes or No to send the 

transmission
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LETS TRY IT

 1. COMMUNICATIONS

 2.SEND FED/ST

 PICK ONES WANT/SELECT ALL

 3.SEND

 4.UP COMES DCR REPORT

 5.REVIEW IT

 6.ARE YOU CONNECTED TO PRINTER?

 7.IF SO PRINT DCR otherwise STOP
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 Automatically 
initiates the 
communication 
session

 Communication 
progress will be 
displayed

 Blue progress 
bar

 Communication 
results will be 
displayed

The communication process begins 

after clicking Yes to verify your DCR 

information
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 Click the Disconnect button 
at any time to stop the 
transmission

 Disconnect button will 
change to Connect when the 
transmission is finished

 Connect button will be 
disabled

 Click Close if session was 
successful

Note: TaxWise erases the 
electronic file once the 
transmission is successful.

Cancel the Transmission at any time
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 Displays 
transmission 
messages

 Identifies the files 
you are picking up

 Indicates if you do 
not pick up any 
files

 No Mail to Toss

 Indicates if your 
communication 
session was 
successful

Review the Session Information

for transmission messages
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 Click Connect to try 
again

 TaxWise will try to 
resend the transmission

 Click Close to try again 
at a later time

 TaxWise stores the 
transmittal file

 Will be prompted to 
send the transmittal file 
the next time you click 
Send Federal/State 
Returns to.

 Click Retransmit Batch
to send the transmittal 
file

 Click Unbatch to remove 
the transmittal file

Troubleshooting Tip:  What should I 

do if my communications session is not 

successful?
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 CCH cannot stop returns 
that have been 
electronically filed

 E-files are automatically 
placed into a transmittal 
file to send to the IRS

 Correct mistakes if the 
IRS rejects the return

 File a 1040X if the IRS 
accepts the return

Troubleshooting Tip:  Can CCH stop 

a return that I filed by mistake?

NO
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 The ERO must submit returns to CCH as soon as 
possible

 Must be submitted within 3 calendar days 
from completion of return

 Return is not complete until both taxpayers 
have signed  and should not be transmitted 
till have both signatures

 Review the DCR for any errors

 Print the DCR

3189 Guidelines:  Transmitting Returns
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Form 8879

 2 copies

 Top line

 Both copies signed
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 Year round training 
tool

 Gives preparers the 
opportunity to 
experience tax 
season all year

 Simulates IRS 
acknowledgements

 Accepted returns

 Rejected returns

What is the Training Electronic Filing 

Center?
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 Requirements:

 Must be logged in as the 
Training User or any user 
assigned to the Training 
Group

 Must have internet access

 Must use TaxWise 2009 prior 
to December 10th

 Must use TaxWise 2010

after December 10th

 Recommendations:

 Access to a printer to print 
out DCR and 
Acknowledgement reports

Training Electronic Filing Center 

Requirements
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 IRS Accepted acknowledgement 
for returns in which the primary 
SSN starts with an even number 
(0, 2, 4, 6, 8)

 IRS Rejected acknowledgement 
for returns in which the primary 
SSN starts with an odd number 
(1, 3, 5, 7, 9)

» Rejects codes are random and not 
related to the return information

» Rejected returns will never be 
accepted because the primary SSN 
is an odd number 

Experience both Accepted and 

Rejected returns
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• Login as the Training 
User or any user 
assigned to the Training 
Group

• Create a return

• Create an e-file

• Open the 
Communications menu

• Select Send 
Federal/State Returns 

• Click Yes on the 
confirmation box

Transmitting to the Training Electronic 

Filing Center
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 In this lesson we have covered:

 The life cycle of an e-file

 Electronic filing of New Jersey returns

 Checks to make before transmitting

 Sending returns to UTS

 The Training Electronic Filing Center

 What questions do you have?

Lesson Summary:  Transmitting



2009 Tax Season ERO TRAINING - MODULE 0 67

ERO (Transmitter) Training

Module 4

Acknowledgements

& Email
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Communications from TaxWise

 Acknowledgements 
are posted to your 
UTS Electronic 
Mailbox

 IRS

 IRS Acknowledgment

 ST

 Fed/State e-file Ack

 EMAIL 

 TaxWise Mail
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Availability of Acknowledgements

 Federal: 6 to 48 hours after returns 
transmitted

 NJ: 1 to 7 days after Federal ACK

 Have printer ready

 Request from Communications menu

 Email will download at same time

 Available acknowledgements (ACK)  
and email will automatically 
download when transmitting e-files
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GETTING ACKNOWLEDGEMENTS

 Communications/Get Acknowledgements/
 Get
 Connects to site
 Up comes list
 False/True
 One or more than one can be checked
 Gives summary then ask for “details”

 Print Fed Acks 
 Attach 8879s to Ack and save
 State Acks no need to print, still 

IMPORTANT
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Database acknowledgements 

will automatically process

 Automatically 
process when the 
communications 
window is closed

 Receive database 
updates 
frequently
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 Defaults to Wide 
Format

 Defaults to show 
only unprocessed 
acknowledgements

 Select the files you 
want to process

 Click OK
Note: You should process 

and print all 
acknowledgements.

Select acknowledgement window lists 

the available acknowledgement files
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FORGOT TO PRINT   

ACKNOWLEDGEMENT

 Go to “REPORTS”

 ACKNOWLEDGEMENTS

 this list all, just pick by date and 
print
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A summary of each acknowledgement 

file appears on your screen

 List a brief summary 
of what each 
acknowledgement 
files contains

 Total returns in file

 Total returns 
accepted

 Total returns 
Rejected

 Click the Details
button to display the 
full acknowledgement

 Allows you to print 
your 
acknowledgement
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Show and tell

 View one report

 Summary then need detail

 Print

 Or choose several reports, details, 
and print

 Email from CCH
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REJECT REPORT

 FROM ACK SCREEN, CLICK THE 
“REJECT” BUTTON TO DISPLAY 
THE REASONS FOR ANY 
REJECTED RETURNS

 CLICK THE PRINT BUTTON TO 
PRINT THE REJECT REPORT
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 Click the Printer
icon

 Click OK to print
 Click Cancel to quit 

the printing process

 Close the 
Acknowledgement 
window
 Click the X in the 

upper right corner 
of the window

 Click OK on the 
View Processed 
Acknowledgements
window

Print your Acknowledgements
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 Print all Acknowledgement Reports

 This will print the reject details

 Save the Acknowledgement report for end of season 
reporting

 Verify acceptance of Federal and New Jersey 
returns

 Compare to DCR report

 The DCR report can be shredded once all returns have 
been accepted

 Retain Forms 8879 with W-2’s and 1099’s for 
year end submittal to IRS

3189 Guidelines:  Acknowledgements
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 Detailed reject 
information 
contains:

 TIN (Social Security 
Number)

 DCN 

 Form Reference

 Copy Number

 Sequence Number

 Error Code

 IRS description from 
the 1345A

 TaxWise Correction 
Suggestion

Detailed Reject information prints 

with the IRS acknowledgement
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MAJOR REASONS FOR REJECTS

 INCORRECT SOCIAL 
SECURITY NUMBERS

MISSPELLED NAMES 

 LAST NAME USED ON 
RETURN DOES NOT MATCH 
SOCIAL SECURITY RECORDS

 INCORRECT EINs 

 INCORRECT EMPLOYER OR 
PAYER NAMES
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 Open the rejected 
return

 Form containing the 
error will have a red 
exclamation point 
(!)

 The rejected entry is 
typically in red

Fixing the Rejected Return in TaxWise
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FIXING REJECTS  Continued

 ERROR CODE INDEX & FIELD NUMBERS 

FOUND IN PUB 1345A 

 CONTACT TAXPAYER BY PHONE OR BY 
LETTER TO GET CORRECT INFORMATION

 FIX THE ERROR

 RUN DIAGNOSTICS AND CREATE AN E-
FILE RETURN

 IF THE RETURN DOES NOT INVOLVE 
MAJOR CHANGES, RETRANSMIT THE 
RETURN
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REJECTS REQUIRING NEW 

SIGNATURES &/OR PINS

 CHANGES THAT ARE MORE 
THAN

$50 TO “TOTAL INCOME” OR 
“AGI”

$14 TO “TOTAL TAX,” 
“FEDERAL INCOME TAX 
WITHHELD,” REFUND,” OR 
“AMOUNT YOU OWE.”
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SUGGESTED METHOD

 1. CALL TAXPAYER

 2.FIX ERROR (ones that involve $ 
changes)

 3.create efile and resubmit

 4.print out new return for taxpayer 
to replace old one, new 8879s to be 
signed  MUST DO!!!

 5. meet at site for quick signing
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REJECTS THAT MUST BE PAPER 

FILED

 CHANGE IN NAME

 CHANGE IN SSN

ANOTHER TAXPAYER HAS 
CLAIMED THE SAME 
DEPENDENT
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 Fix the reject

 Run 
Diagnostics

 Create a new 
e-file

 Transmit the 
return

Resend the return after reject 

corrections are complete
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STATE RETURN REJECT

 Fix the error

 State e-file help if needed

 Resend efile

 Will be a state stand alone

 FYI cannot do a NJ stand alone 
without Federal return except when 
correcting error



2009 Tax season ERO TRAINING - MODULE 0 88

 The following should be kept confidential and in a 
secured location until the end of tax season. 

 One signed Form 8879 for each return 
transmitted with one copy of Forms W-2/1099

 Master backup disk with all electronically 
transmitted returns

 Copy of IRS Acknowledgement Report for 
transmitted federal returns

IRS Record Keeping Guidelines



2009 Tax season ERO TRAINING - MODULE 0 89

Comments
Questions
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ERO (Transmitter) Training

Module 5

Reports
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 In this lesson we will:

 Learn how to run a TaxWise report

 Learn how to filter and sort the report

 Discuss typical reports

 IRS Electronic Filing Summary

 Preparer Field Values

 Learn how to print reports

Lesson Overview:  

TaxWise Management Reports



2009 Tax season ERO TRAINING - MODULE 0 92

Steps for running a TaxWise report 

 Login as the appropriate 
user

 Users assigned to Training 
do not have access to 
reports

 Open the Reports menu

 Select Reports List

 Highlight the desired 
report

 Press Enter

 Click OK on Report 
Criteria window
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 Click the Help
button on Select a 
Report to Print

 Click the 1040 
Report 
Descriptions link

Use Help to determine which 

reports to use at your site



2009 Tax season ERO TRAINING - MODULE 0 94

TYPICAL REPORTS REQUIRED

 IRS Electronic Filing Summary

 Print and send to IRS Newark at 
end of season
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Specify the Report Criteria

 Normally use 
defaults

 Filter by DCN if 
multiple EFINs or 
to isolate 
computers

 Can change sort 
field
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IRS Electronic Filing Summary

Print and send to IRS Newark with 
8879s, taxpayer forms and e-file 
backups



2009 Tax season ERO TRAINING - MODULE 0 97

 In this lesson we have covered:

 Running a TaxWise report

 Report criteria

 Examples of reports

 Printing a report

Lesson Summary:  TaxWise Management 

Reports
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ERO (Transmitter) Training 

Module 6

TaxWise Updates
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 Each email address 
submitted with IRS 
orders are 
automatically signed up 
for the following 
notifications

 TaxWise 

 Resident State

 Click the Notify me by 
e-mail when my 
products are 
updated link

Receive an email notification when a 

Federal or State update has been released
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 Click to place check 
mark next to New 
Jersey

 Scroll to the bottom 
of the page and click 
Save

Select the States for which you want to 

receive initial release and update 

notifications
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Update Files

 Federal updates are usually several MB

 Downloading from the TaxAide web site 
with a broadband internet connection is 
recommended

 Libraries usually have high speed internet 
access that can be used to download to a 
flash drive

 If using a dial-up connection, download 
during the night



2009 Tax season ERO TRAINING - MODULE 0 102

Get the latest versions of TaxWise

Customer Support tab

 Click Download from 
the Home page 

 TaxWise Program 
Updates gives the 
ability to update one 
version at a time

 TaxWise 
Comprehensive 
Updates include all 
updates in one 
download

 View readme files prior 
to downloading 
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 Click the download
icon to begin 
downloading

 Each time the federal 
program is updated, 
it will be listed on the 
TaxWise Updates
screen

Note: Clicking the release 

notes icon will allow 
viewing of what is 
included and/or fixed.

Select the appropriate Federal 

Update to download
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 Open Option:

 Allows the installation of 
the module without 
saving the installation 
file to the hard drive

 Save Option

 Requires the installation 
file to be saved to the 
hard drive/flash before 
the module can be 
installed

The File Download dialog box will 

display after selecting the update
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 Select the destination for 
the installation file

 Remember where the file 
is being saved so it will be 
easy to locate once the 
state module is ready to 
be installed

 Double-click on the 
installation file to install 
the module

Note: The desktop is the most 
common location to save a 
file.  Do not save to the 
UTS09 folder.

If the option to save was selected, a Save 

As dialogue box will be displayed
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 Simply click Next to 
continue.

The installation has easy to follow

on-screen instructions
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The installation will give a list of drives 

available to install the module

 Select the drive where 
TaxWise is installed

 If the drive is 
encrypted, it must be 
mounted
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Finishing Up

 The Update has 
been installed

 The update will 
automatically apply 
the next time 
TaxWise is 
opened

 Click Finish to 
continue
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Viewing the Readme notes

 Once the Federal 
update has been 
installed, the 
associated readme 
notes will 
automatically open
 Program changes

 Laser forms

 New tools and 
options

 Close Readme and 
click Finish to close 
the update wizard.
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Open TaxWise to apply the Federal 

update

 Click Yes to 
continue with the 
update process

 View the update’s 
progress
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The TaxWise update is now complete

 Once the update is 
complete, a pop up 
will list both the 
previous version 
and the newly 
updated version

 Click OK and 
TaxWise will 
automatically open



2009 Tax season ERO TRAINING - MODULE 0 114

 Click the State 
Updates link to 
access state 
downloads

 The latest version of 
the state is always 
available

 All state versions are 
combined in the 
update

Download state files for initial 

installation and state updates
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 Click the Release 
Notes icon to view 
important 
information about 
the state update

 Click the 
Download icon to 
begin the 
download process

Select the appropriate state module to 

download from the State Updates sub-page
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 Simply click Next to 
continue

The State Installation has easy to follow

on-screen instructions



2009 Tax season ERO TRAINING - MODULE 0 117

There are two options given during the 

installation of the state module

 Make a state flash

 Allows the user to put 
the state module on a 
disk which can be used 
to install the state on 
non-networked and/or 
non-connected 
computers

 Install XX 
Individual to this 
computer

 Installs straight to the 
computer
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 Select the drive where 
TaxWise is installed

 If the drive is 
encrypted, it must be 
mounted

 Only one drive can be 
selected at a time

Select a target drive for the state
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 The location where the 
state module was 
installed will be listed in 
the confirmation box

 Click OK in the 
confirmation box

 Continue for other setup 
options

 Exit the installation

 Continuing will allow 
creation of an installation 
diskette/flash

A confirmation box will appear once the 

installation has been completed
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 An option to view 
additional information 
about the state module 
will be available via a 
readme file

Release notes can be viewed after 

the installation has been completed
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Updating EFC Computers

 Federal updates and state modules 
can be installed by saving the 
update to a flash drive and opening 
the update file on the EFC computer

 Alternately, updates can be 
transferred between computers 
using the Tools menu
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 Open TaxWise

 You do not have to log 
in

 Open the Help menu

 Select About 
TaxWise

 Verify the version 
number

 Click OK

Note: You must complete this 
process on all stand alone 
computers.

Troubleshooting Tip:  How can I tell if 

TaxWise updated to the correct version?
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 Open the TaxWise 
Utility Program

 Open the Setup menu

 Select View 
Authorization

 Packages and Options

 Individual States 
(Version)

 Pay Per Return 
Authorization

Troubleshooting Tip:  How can I tell if the 

State installed or updated completely?



2009 Tax season ERO TRAINING - MODULE 0 124

Other Updates

 TaxWise Help, Federal Help and 
Utility updates are sometimes 
posted on the TaxWise web site.

 These updates can be downloaded 
and installed like the Federal and 
state updates
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 Quick look at what we have covered:

 Receive email notification of updates

 Download Federal Update

 Download State Files

 Install Federal Updates from flash

 Install State(s) and State updates from flash

 What questions do you have before 
continue?

Quick Recap: Federal and State Installation 

Transfer and Updates 
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ERO (Transmitter) Training

Module 7

Utility Program
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 In this lesson we will cover:

 Learn how to use TaxWise Explorer 
to manage your TaxWise files

 Learn how to copy Tax Form 
Defaults to disk

 Learn how to use Utility File Menu

 Learn how to send TaxWise 
customer support a tax return 
using Compose/Send message

Module 7 Overview: 

TaxWise Utility Program
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 Steps to opening the 
TaxWise Utility Program

1. Login as Admin

2. Open the Tools menu

3. Select Utilities/Setup 
Options

 TaxWise Utility has the 
following menus

» File

» Communication

» Tools

» Setup

» Help

TaxWise Utility handles setup, file 

maintenance, software updates, and e-mail
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 The Admin user has 
access to files in all 
user directories

 All other users can 
only access files 
belonging to the 
active user

 Locating TaxWise 
Explorer from the 
Utility Program
 Open the File menu

 Select TaxWise 
Explorer

The Site Administrator can use 

TaxWise Explorer to manage files



2009 Tax season ERO TRAINING - MODULE 0 130

 Copy Files to Another User -- Use this action to 
copy Tax Form Defaults, Form Print Defaults, and 
History lists from one user to another. 

 You cannot copy tax returns to another user.

 Delete Files -- Use this action to delete tax 
returns and other files. 

 The file cannot be restored.

 Move Files to Another User -- Use this action to 
move tax returns and other files from one user to 
another.

Actions that are available for file 

management in TaxWise Explorer
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 Expand the folder 
or drive to show 
subdirectories

 Click the plus sign 
(+)

 Admin user can 
select files in any 
folder or drive

 Other user names 
can only select 
files from their 
own user name

Use the Look in box to find the file 

or files you want to select
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 SSN/EIN

 Taxpayer Name

 Return type

 Date created

 Date last edited

 Date last 
printed

 Preparer ID

Statistical information displays for 

the highlighted return
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 Select user name

 Select file name

 Select Action Delete 
files

 Click the Delete button

 Click Yes on 
Confirmation box

Note:  You cannot recover 
deleted files or returns.  
Make sure you have a 
backup before deleting 
returns.

Use TaxWise Explorer to delete returns
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 Select user name

 Select file name

 Select Action 
Move files to 
Another User

 Select a user 
name

 Click the Move
button

Move returns from one user name 

to another user name
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 Quick look at what we have covered:

 Copy files to another user

 Delete returns and files

 Move returns to another user

 What questions do you have before we 
continue?

Quick Recap:  TaxWise Explorer 
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REMINDER

 A good EFC can help you maintain 
their own computer

 Teach then how to update using 
desktop icon

 Teach then to delete files after they 
are accepted.

 Keep them out of ADMIN
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 Open the File
menu

 Select Erase e-
files…

 Select the e-files 
to erase

 Click OK

 Re-create an e-
file by opening 
the return and 
running 
Diagnostics or 
by using Make 
IRS e-file 

Remove tax return e-files that were

created by mistake
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 Quick look at what we have covered:

 Learned how to use TaxWise Explorer to 
manage your TaxWise files

 Learned how to use some of the Utility 
File Menu

 What questions do you have before we continue?

Quick Recap:  Utility Program 
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TC Module 8:

Technical Tips and Good Practices

In this lesson we will cover:

 Passwords

 TrueCrypt Auto start

 Managing E-files

 Restricting EFC access

 Display Resolution

 How to be prepared when you call 
TaxWise Customer Support
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Security Vulnerabilities

 Equipment possession
 Unattended during site setup, 

operation or end of day pack up

 In sight in vehicles

 Password compromise
 Access restriction depends on password

 Providing the password removes the 
barrier

 Why bother to encrypt if the password 
is provided?
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Passwords

 Required for

 computer operating system (all users)

 Encryption software

 Taxwise 

 Can be remembered by computer 
users (should not be written down)
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Security Note

 If passwords are written, they 
should not be on the computer, in 
the computer case or on anything 
that goes into the computer case 
(like the volunteer’s name tag)

 Good idea for you to keep 
passwords of all EFCs if they differ
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Backing up returns should be part 

of your daily routine

 Backup returns 
on a daily basis

 If something 
happens to your 
computer, this is 
your only way to 
recover your tax 
returns
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Managing E-files

 Tracking returns from preparation 
to delivery to IRS (Cradle to grave)

 EFC to ERO

 CCH/IRS/NJ accept/reject

 Mail if cannot be e-filed

 Goal: Don’t misplace any 
returns!
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Managing E-files – Considerations

 Electronic copy of return and 
associated paper

 Extra paper – avoid if possible

 Self-checking (Audit) – needed 

 EFC burden – minimize
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Managing E-files – Options

 TaxWise reports

 Track & audit

 No additional data entry or paper

 TaxWise Users

 Add Users for “Complete” 

 Move returns accepted by IRS and NJ 
from site user to Complete user
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Managing E-file Paper – Options

 8879 plus withholding documents 
for each return

 File folders for

 Ready to transmit

 Awaiting ACK

 Accepted (Federal and NJ) – holding 
until sent to IRS
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User Names & Passwords

Recommendations:

 User for each e-file site

 User(s) for completed returns

 Same password for Admin, Training 
& Guest (consider deleting the 
Guest user) on all district 
computers, known to EROs only

 Passwords in CAPS
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 Know your EFIN

 Must enter prior to being 
transferred to a Customer 
Service Representative

 Be at your computer

 Write down the exact error 
message

 Describe the exact function 
you were performing when 
you received the error

 Know the SSN when checking 
the status of a return

Tips for getting the most efficient 

Customer Service
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 In this lesson we have covered:

 TaxWise Use

 Passwords

 Managing E-files

 Being prepared when you call TaxWise Customer 
Support

 What questions do you have ?

Module 8 Summary:

Technical Tips and Good Practices
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ERO (Transmitter) Training 

Module 9

Post-Filing Season Procedures
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 In this lesson we will cover:

 Transferring data for storage

 Destroying data records

 Completing a backup of electronically 
filed returns

 Deleting Taxpayer data

Lesson Overview:  

Post-Filing Season Procedures
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Records Transfer

 To IRS Newark by April 30

 Acknowledgements

 Signature and withholding documents

 Backup with all e-files

 You will never see these records again!

 Note: some EROs send this data monthly

 If retaining taxpayer data, to TCS by April 
30  (Gary Broughton)

 Backup of returns authorized for retention

 Data will be returned to TC by end of year
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Packaging for shipment

 Package securely to prevent 
damage or loss

 CD mailer

 Padded mailer for flash drives

 Durable envelope

 Return address on flash drive
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Data disposal

 All records (paper and electronic) 
with taxpayer data not transferred 
should be destroyed by April 30

 Shred DCNs, tracking sheets, logs

 Cut CDs and floppy disks

 Delete files on flash drives

 Remove data from computers per 
IRS and AARP directions
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 For IRS: Complete 
backup of all returns 
electronically filed

 For TCS: backup of 
returns authorized for 
retention

 Use Regular Backup

 Test the backup prior 
to removing your 
TaxWise software

Post-Filing Season Backups
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DELETE ALL RETURN DATA

FROM COMPUTERS

 Run a disk wipe program for all IRS 
computers.

 Follow TCS directions to delete all 
taxpayer data from personal and/or 
AARP computers.

 Optional for AARP and personal 
computers: Download TPClear from 
http://www.aarp.org/tavolunteers/

http://www.aarp.org/tavolunteers/
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 In this lesson we have covered:

 Transferring data for storage

 Destroying data records

 Completing a backup of electronically 
filed returns

 Deleting Taxpayer data

 What questions do you have?

Lesson Summary: 

Post-Filing Season Procedures
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Multiple EFINs

 When you are transmitting for more 
than one site

 You must use a transmit efin so that 
your database can sort the data 
properly

 Acquired through Taxwise

 Set up with your TC
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